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Representation of Interactions in Data Model for Hybrid Structural Experiments
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Abstract

The hybrid structural experiment decomposes a structure into independent substructures that can be tested or simulated. The
substructures being tested or simulated may be distributed at different facilities of different locations, and are managed by the
simulation coordinator. There exist interactions among the simulation coordinator and the substructures since they give and receive
the commands and feedbacks during the experimental process. These interactions are described in this paper for an example hybrid
structural experiment using the classes and objects in the Lehigh Model which is one of the data models for structural experiments.
The simulation coordinator and the substructures have the objects for the interaction data files, and are linked together through the
same types of the interface links. The objects for the interactions presented in this paper can be implemented in a consistent way,
and be used for developing the computer system for the hybrid structural experiments.

Keywords - hybrid experiment, substructure, interaction, data model, Lehigh Model
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the analytical process. The hybrid structural experiment

Structural engineers have investigated the behaviors
of structures by physical experiments or analytical
computations. A physical experimental method uses a
physical specimen, applies the loads, and measures
the structural responses. An analytical computational

method needs a computer simulation model to perform

combines the physical experiments and the analytical
computations for decomposed substructures to predict
the behaviors of the entire structure. This approach
is especially useful for the distributed hybrid pseudo-
dynamic experiment, and allows to overcome the size
and geographical limitations of the experiment.

Data models for the hybrid experiments formally
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organize and represent the information involved in
the experiments. The formally represented information
can be used for developing the computer systems.
Some noticeable data models for earthquake engineering
experiments including the hybrid experiments have
been developed in support of the George E. Brown Jr.
Network for Earthquake Engineering Simulation(NEES;
http://nees.org/, 2009), which is a shared national
network of 15 experimental facilities in the United
States. The Model(Oregon State

University and Network Alliance for Computational

Oregon State

Science and Engineering, 2003) was for tsunami
wave basin experiments, and the Reference NEESgrid
Data Model(Peng et al., 2004) for shake table
experiments. The Lehigh Model(Lee et al., 2008) was
intended for the large-scale structural experiments,
and explored the explicitly categorized classes for
representing the information involved in the hybrid
experiments. The NEEScentral Model (NEESit, 2009)
was developed for general structural experiments,
and has recently extended its applications to the
hybrid experiments.

The Lehigh Model(Lee et al., 2008) and the NEES
central Model(NEESit, 2009) contributed towards the
comprehensive data models for the hybrid experiments
by providing the essential classes for the decomposed
physical and analytical substructures and the simulation
coordinator managing the substructures. However,
there are still many parts of the models that need to
be refined and described in detail. They include the
interactions among the simulation coordinator and
the substructures. Lee et al.(2009) discussed the
links and interactions among classes in the Lehigh
Model for the hybrid experiments. The classes for the
simulation coordinator and substructures of a hybrid
structural experiment are linked through a same
class, but their interactions have not been fully
inspected.

The objective of this paper is to give the detailed
descriptions of the interactions among the simulation
coordinator and substructures in the Lehigh Model
for the hybrid structural experiments. The organization
of the Lehigh Model is compared with that of other
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data model. An example of the hybrid experiments is
presented, and the interactions existed in the example
hybrid experiment are represented using the classes
defined in the Lehigh Model. Then a possible imple-
mentation of the objects of the classes is provided to
consider the practical usability of the model and to
discuss feasible applications into other data models

for the hybrid structural experiments.

2. Comparison of Organizations of Data Models
for Hybrid Experiments

Fig. 1 compares the conceptual organizations of
the Lehigh Model(Lee et al., 2008; 2009) and the
NEEScentral Model(NEESit, 2009). Only parts for
the hybrid experiments from the data models are
compared, and the main classes are shown in the
figure.

For the Lehigh Model in Fig. 1la, one hybrid
experimental task involves a simulation coordinator,
a number of physical substructures, and a number of
analytical substructures. The simulation coordinator
involves a number of simulations. Each physical
substructure involves a number of physical substructure
tests, and each analytical substructure a number of
analytical computations. Each simulation involves a
data set, each physical substructure test a data set,
and each analytical substructure computation a data
set.

Compared with the Lehigh Model, the NEEScentral
Model in Fig. 1b has a different organization. One
hybrid project involves a coordinator and a specimen.
The coordinator involves a number of coordinator
runs, and each coordinator run involves a number of
physical substructures and a number of analytical
substructures. Each physical substructure involves a
trial which involves a number of data, and each
analytical substructure involves a run which involves
a number of data. The specimen involves a number of
specimen components. Each specimen component may
involve a number of specimen subcomponents.

The conceptual organizations in Figs. la and 1b
show that the Lehigh Model and the NEEScentral
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Fig. 1 Comparison of organizations of data modelsfor
hybrid structural experiments

Model have their own focuses of representing the
information involved in the hybrid experiments. The
Lehigh Model makes a clear distinction among the
simulation coordinator, the physical substructures,
and the analytical substructures. This provides easy
understanding of the model, but the interactions
among the simulation coordinator, the physical
substructures, and the analytical substructures need
to be thoroughly described. The NEEScentral Model

puts more emphasis on the links among the coordinator,
the physical substructures, and the analytical subs—
tructures by placing the substructures at the lower
level of the coordinator. The specimen and the
facility(not shown) are not closely related with the
coordinator and each of the substructures. For the
cases that the specimen and facility information is
important, the models needs to provide easy access to
the information from the coordinator and each of the
substructures.

The Lehigh Model is considered in this paper, and
the interactions among the simulation coordinator
and the substructures are discussed in the later

sections using an example hybrid experiment.

3. Interactions in Example Hybrid Experiment

3.1 Example Hybrid Experiment

An early significant example for the hybrid structural
experiments is the Multi-site Online Simulation
Test(MOST; The MOST Experiment, 2003). The
computer techniques related with the MOST experi-
ment are described by Pearlman et al.(2004). Fig. 2
shows the outline of the experiment. A two-bay single
story steel frame is divided into two experimental
substructures and one analytical substructure in Fig.
2a. Two experimental substructures are tested at the
University of Illinois of Urbana-Champaign(UIUC)
and the University of Colorado. One analytical subs-
tructure is simulated at the National Center for
Supercomputing Applications(NCSA). The three subs-
tructures are integrated by the NEESgrid Teleoperations
Control Protocol(NTCP) server, and the simulation
coordinator provides the overall management of the

experiment(Fig. 2b).

3.2 Interactions in Example Hybrid Experiment

For the example hybrid experiment shown in Fig. 2,
there exist interactions among a simulation coordinator,
and an analytical

two physical substructures,

substructure. Fig. 3 shows an example of the interactions,
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Fig. 2 Hybrid structural testing
(after Pearlman et al. (2004))

which is arbitrarily made for the discussion in this
paper. In the figure, the simulation coordinator
involves two simulations(MOST Simulation 1 and
MOST simulation 2), each physical substructure two
tests(Left Column Test 1 and Left Column Test 2;
Right Column Test 1 and Right Column Test 2), and
the analytical substructure two computations(Center
Frame Computation 1 and Center Frame Computation
2). The two sets of date and time are arbitrarily
selected for the simulations, physical substructure
tests, and analytical substructure computations. A
simulation(e.g., MOST Simulation 1) is related with
ones of the physical substructure tests(e.g., Left
Column Test 1 and Right Column Test 1) and one of
the analytical substructure computations(e.g., Center
Frame Computation 1).

In Fig. 3, each of the simulations sends commands
to and receives the feedbacks from the related
physical substructure tests and analytical substructure
computation while the hybrid experiment is performed.
the MOST Simulation 1 sends the

Llb, Llc,....) to and

For example,

commands(command Lla,
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receives the feedbacks(feedback Lla, Llb, Llec,....)
from the Left Column Test 1. There are series of
commands and feedbacks defined by the time steps of
the hybrid experiment. After the hybrid experiment
goes to the end, the accumulated commands and
feedbacks can be saved as computer files such as the
csv format files. For example, the MOST Simulation 1
will have three command files(LeftColumnCommandl.
csv, RightColumnCommandl.csv, and CenterFrame
Commandl.csv) and three feedback files(LeftColumn
Feedbackl.csv, RightColumnFeedbackl.csv, and Center
FrameFeedbackl.csv). The Left Column Test 1 will
have one command file(LeftColumnCommandl.csv)
and one feedback file(LeftColumnFeedbackl.csv).

The interactions in Fig. 3 regarding the information
on the commands and feedbacks among the simulation
coordinator and the physical and analytical substru-
ctures can be represented formally by using the
classes and objects defined in the Lehigh model for
the hybrid experiments.

4. Representation of Interactions in Example
Hybrid Experiment

The interactions in an example hybrid experiment
shown in Fig. 3 are represented using the Lehigh
Model.

hybrid experiments, the objects for the interactions

This section presents the classes for the

in the example hybrid experiment, and then the
display of the windows of the possible implementation
for the objects. Table 1 shows the corresponding

numbers for the classes, objects, and windows
which are shown in Figs. 4, 5, and 6, respectively.
In Table 1, the class, object, and window numbers
are grouped for the simulation coordinator, and the
physical and analytical substructures. For example,
the simulation coordinator in the table involves the
simulation coordinator class(Class No. 1) in Fig. 4a
which are related with the MOST
coordinator object(Object No. 1) in Fig. 5a and the
MOST Simulation Coordinator window(Window No.

1) in Fig. 6a. Some of the object and window

simulation

numbers in Table 1 do not have corresponding class
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Fig. 3 Interactions in example hybrid experiment
(Sets of date and time are arbitrarily selected.)

numbers. This means the objects and windows are
from the classes not shown due to space limitations
in Fig. 4. The representation of the interactions in
the example hybrid experiment in this section can
be better understood when Table 1 and Figs. 4, 5,

and 6 are compared together.

4.1 Classes for Hybrid Experiments

Fig. 4 shows the main classes of the Lehigh
Model for the hybrid experiments. The classes and

in the figure and later figures are

represented using

attributes
a modified entity-relationship
diagram developed for entity-based product and
process models(Hong et al., 1994; Lee et al.,
1998). Each rectangle in Fig. 4 indicates an entity
category(referred to as a class). Each attribute of
the class is shown below the rectangle with a
horizontal bar. If the attribute is singe-valued, the
bar ends with an empty circle, and if the attribute
is multi-valued, the bar ends with a black circle.

The value set of an attribute(the set of possible
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Table 1 Corresponding classes, objects, and windows

Class Object Window

Number Number Number
1 1 1
Simulation 2 2 2
Coordinator 2 3 3
(MOST not shown 4 4
Simulation 4 5 5
Coordinator) 4 6 6
5 7 7
8 8 8
Physical 9 9 9
Substructure 1 9 10 10
(Left Column) not shown 11 11
4 12 12
8 13 13
Physical 9 14 14
Substructure 2 9 15 15
(Right Column) | not shown 16 16
4 17 17
10 18 18
Analytical 11 19 19
Substructure 11 20 20
(Center Frame) | not shown 21 21
5 22 22

values for the attribute) is represented in square
brackets. The attribute type identified

parentheses. Attributes of a class are classified into

is in
two main types: (1) "data—valued attributes(DVA) whose
values are alphanumeric or otherwise indecomposable;
and (2) “object entity-valued attributes(OEVA) whose
values refer to other classes.

Figs. 4a, 4b, and 4c¢ show the classes for the
simulation coordinator, the physical substructure, and
the analytical substructure for a hybrid experiment.
The full description for the classes is presented by Lee
et al.(2009), and a reduced description in this paper.
Most of the attributes of the classes in Fig. 4 are
self-explanatory. The class numbers of the classes are
used later for comparison with the objects and
windows in Figs. 5 and 6.

The simulation coordinator class(Class No. 1) in
Fig. 4a represents the information involved in the
simulation coordinator of a hybrid experiment. The
simulation coordinator class includes the attributes
for the description, the simulation model and the
simulation coordinator facility, and the multi-valued
attribute for a number of the simulations, whose value
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set refers to the simulation class. The simulation
class(Class No. 2) includes the attributes for the
description, the start date & time, the end date &
time and the simulation date set, and the multi-
valued attribute for the interfaces to substructures,
whose value set refers to the simulation substructure
interface class. The simulation substructure interface
class(Class No. 3) is a generalization of the physical
substructure interface class(Class No. 4) and the
analytical substructure interface class(Class No. 5)
which are used for the links with the physical
and the
respectively. The attributes for the simulation, the
and the feedback of the

substructure interface class(Class No. 3) are inherited

substructures analytical substructures,

command, simulation
by the physical substructure interface class(Class No.
4) and the analytical substructure interface class(Class
No. 5).

In Fig. 4b, the abstract test condition class(Class
No. 6)
class(Class No. 7) and the physical substructure
class(Class No. 8). The attributes for the abstract

test condition class, such as the specimen and the

is a generalization of the test condition

facility attributes, are inherited by the test condition
class and the physical substructure class. The test
condition class is for the typical experiments. The
physical substructure class is for the hybrid experiments,
and the value set of the multi-valued attribute for the
physical substructure tests refers to the physical
substructure test class. The physical substructure
test class(Class No. 9) includes the single-valued
attribute for the interface to simulation. The value set
of the attribute refers to the simulation substructure
interface class(Class No. 3) which is the same as in
Fig. 4a.

The analytical substructure class(Class No. 10) in
Fig. 4c represents the information involved in the
analytical substructures of a hybrid experiment. The
analytical substructure class includes the multi-
valued attribute for a number of the analytical
The value set of the

analytical substructure computations attribute refers

substructure computations.

to the analytical substructure computation class. The
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analytical substructure computation class(Class No.
11) includes the single-valued attribute for the
interface to simulation. The value set of the attribute
to the
class(Class No. 3) which is the same as in Figs. 4a
and 4b.

It is known in Figs. 4a, 4b, and 4c that a

simulation and its related physical substructure tests

refers simulation substructure interface

and analytical substructure computations are linked
through the simulation substructure interface class
which is a generalization of the physical substructure
substructure

interface class and the analytical

interface class.

4.2 Objects for Interactions in Example

Hybrid Experiment

Fig. 5 shows the objects for the interactions in
an example hybrid experiment shown in Fig. 3.
Each rounded rectangle in Fig. 5 denotes an object.
The objects in Fig. 5a are for interactions of the
MOST simulation coordinator in Fig. 3 and are from
the classes in Fig. 4a. The objects in Figs. bb and
5c are for interactions of the Left Column and the
Right Column in Fig. 3 and are from the classes in
Fig. 4b. The objects in Fig. 5d are for interactions
of the Center Frame in Fig. 3 and are from the
classes in Fig. 4c.

The MOST simulation coordinator object(Object
No. 1) in Fig. 5a is from the simulation coordinator
class(Class No. 1) in Fig. 4a, as presented in Table
1. Using the table, the objects in Fig. 5 and their
corresponding classes in Fig. 4 can be easily found
and compared. The MOST simulation coordinator
object(Object No. 1)
simulation model attribute whose value refers to the
MOST simulation model object, the
coordinate facility attribute whose value refers to
the UIUC Lab object, and the simulations attribute
whose values refer to the MOST simulation 1 object
and the MOST simulation 2 object.

The MOST simulation 1 object(Object No. 2) in

Fig. ba involves the attributes for the description

in Fig. ba involves the

simulation
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and the start date & time, and the end date &
time. The object also involves the simulation data
set attribute whose value refers to the MOST
simulation 1 data set object. The MOST simulation
1 data set object(Object No. 4) involves the raw
data attribute whose values are the three command
feedback files for the three

substructures(see Fig. 3), and the processed data

files and three

attribute whose values are the xls format files. The
MOST simulation 1 object(Object No. 2) also involves
the interfaces to substructures attribute whose
values refer to the three interface objects for the
three substructures, which are the left column test
1 simulation interface object, the right column test
1 simulation interface object, and the center frame
computation 1 simulation interface object. The left
column test 1 simulation interface object(Object No.
5) involves the attributes for the command and
feedback files. The object also involves the physical
substructure test attribute whose value refers to
and links to the left column test 1 object(Object
No. 9). The right column test 1 simulation interface
object(Object No. 6) and the center frame computa-
tion 1 simulation interface object(Object No. 7) are
similarly formulated, and involve the links to the
right column test 1 object(Objet No. 14) and the
center frame computation 1 object(Object No. 19).
It needs to be noted that the MOST simulation 1
data set object(Object No. 4) involves the three
command files and three feedback files for the three
substructures, but each of the objects for the
substructures(Object Nos. 5, 6, and 7) involves a
command file and a feedback file. The MOST
simulation 2 object(Object No. 3) is similar to the
MOST simulation 1 object(Object No. 2).

The left column object(Object No. 8) in Fig. 5b
involves the specimen attribute whose value refers
to the left column specimen object, the facility
attribute whose value refers to the UIUC Lab
object, and the physical substructure tests attribute
whose values refer to the left column test 1 object
and the left column test 2 object. The left column
test 1 object(Object No. 9) involves the data set
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o (B-OEVA) rght col test 2 sim_intf RightColumnCommand1.csv
(MOST simulation 1 ) cen fr comp 2 sim intf (B_DVA)
d . } feedback .
escription ., "This simulation is Object WO RightColumnFeedback1.csv
(B-OEVA) to investigate ..." No. 4 phy sub test
$start +--(MOST simulation 1 data set) b e orm o (fight col test |
date & time ., July 30 2003 : LeftColumnCommand1.csv + : To right column
(B-OEVA) 10:00 am : LeftColumnFeedbackl.csv :: ~  =reeees test 1 object
end : raw data _ RightColumnCommand1.csv Object (Object No. 14)
date & time _ July 30 2003 : (B-DVA) (F;ightclglumngeedbaclgfcsv No. 7
B-OEVA 11:00 am H enterFrameCommand1.csv ¥ iR
:( ) : CenterFrameFeedbackl .cov (Icenter frame comp 1 simulation interface )
sim data set - : :
=== 92 6 (MOST sim 1 data set )---+ LeftColumnCommand1 .xls command
FEi—ofEVA) . gra?acessed Eeﬁh(t;glulmm:%edbacmd);lsl (B-DVA) CenterFrameCommand1.csv
interfaces to — .. ightColumnCommand1 .xls
substructures left col test 1_sim intf (B-DVA) RightColumnFeedback1.xls %o CenterFrameFeedback1.csv
(B-OEVA) right col test 1 sim Intf : CenterFrameCommand1 .xls (B-DVA)
{cen fr comp 1 sim intf ): CenterFrameFeedback1.xls ana sub comp
---------------------------------------- “Botvm° (c_enter frame compi )
e L L L L L L L L P TP PP PP PP PP PP H H To center frame
B e e e e acmeesseecsmescsmesccmesacmeeecmaenan - eeseses computation 1 object
(Object No. 19)
(a) Objects for simulation coordinator(MOST simulation coordinator)
Object i Object Object
No. 8 R No. 9 No. 10 .
(Ieft column ) ’{ left column test 1) (Ieft column test 2 >
description . I description " description
L —==_ =" 6 "The left column HE Test 1 of the left Test 2 of the left
I(8-DVA)  “of the frame was ... : : [(B-OEVA) column of the frame ..." (B-OBVA)  ~ column of the frame ..."
1 specimen n E . H start H start
(S_OTA)O left col specimen) : : |date & time  July 30 2003 date & time  July 30 2003
tacilty i+ [(B-OEVA) 10:00 am (B-OEVA) ~ 1:00 pm
0 -UIUC Lab N end end
(8-0EVA) 1 [date & time _ July 30 2003 date & time _ July 30 2003
phy sub it [(B-oevA) 11:00 am (B-OEVA)  2:00 pm
tests left col test 1 y-=-= . H
= (eft coltest 2 ) ----- :
(B-OEVA) %O(Ieﬂ col test 1 data set) %O(Ieﬂ col test 2 data set)
ir]terflage to ir]terflatt:_e to
(B-OEVA) left col test 1 intf : : (B-OEVA) left col test 2 intf
Object Object
No. 11 1 ¢ No. 12
left column test 1 data set ) - {left column test 1 interface )
raw data _ LeftColumnCommand1i.csv simulation
(B-DVA) " LeftColumnFeedback1.csv (B-OEVA) MOST s.lmulat|on ! 1o MoST
processed Bremenees object
data LeftColumnCommand1.xls command (Object No. 2)
(B-DVA) © LeftColumnFeedback xis B-ova) ° LeftColumnCommand].csv
feedback

WO LeftColumnFeedbackl.csv

(b) Objects for physical substructure 1(left column)

attribute whose value refers to the left column test
1 data set object. The left column test 1 data set

Fig. b Objects for example hybrid experiment

object(Object No. 11) involves the raw data attribute

whose values are the command and feedback files for
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Object : Object Object
No. 13 i No. 14 No. 15 -
(right column ) '( right column test 1 ) right column test 2 )
description , »Tphe right column description "Test 1 of the right description "Test 2 of the right
I(8-DVA)  "of the frame was ... : : |(B-OEVA) column of the frame ..." (B-OBVA) " column of the frame ..."
| specimen - - Yol Bstart 3 start
(B=OEvA] 1 |date & time  July 30 2003 date & time _ July 30 2003
facility 'EIT) ¢ 1 [(B-OEVA) 10:00 am (B-OEVA)  1:00 pm
= CU Lab o end end
(B-OEVA) ¢ |date & time _ July 30 2003 date & time _ July 30 2003
phy sub v (B-OEVA) 11:00 am (B-OEVA) 2:00 pm
tests (right col test 1)---* : :
(B-OEVA) right col test 2 %o(nght col test 1 data set ) %O(nght col test 2 data set )
interface to interface to
?gn_g+zr;o right col test 1 intf ’. %o right col test 2 intf
Object T=wmeresmeresmsrmsmsrmnmnnennnd 3 oy
No. 16 ¢ T No. 17
right column test 1 data set ) - {right column test 1 interface )
raw_data _ RightColumnCommandi.csv simulation
(B-DVA)  RightColumnFeedback1.csv B-oeva) ° (MOST s.lmulat|on ! JJo MOST
processed B object
data RightColumnCommand1 .xIs command ) (Object No. 2)
(B-DVA) © RightColumnFeedback1.xls B-pva) ° RightColumnCommand].csv
%o RightColumnFeedback1.csv
(c) Objects for physical substructure 2(right column)
Object ! Object Object
No. 18 : No. 19 No. 20 .
(center frame ) ’ center frame computation 1 ) center frame computation 2 )
| description  "at NCSA, a Pentium : description "Computation 1 of th description "Computation 2 of th
1 (B-DVA) 2.4 GHz Windows ..." : (B-OEVA) center frame was ..." (B-OEVA) center frame was ..."
| ana sub dor Sstat istart
model : date & time _ July 30 2003 date & time . July 30 2003
[(B-OEVA) © \S&l Il mode I (B-OEVA) 10:00 am (B-OEVA) 1:00 pm
ana sub P g”? - gn? g i
facility - ate & time ., July 30 2003 ate & time  July 30 2003
mo NCSA I (B-OEVA) 11:00 am (B—-OEVA) 2:00 pm
¥ ana sub o ana sub i ans sub
|comos . --4 + |dataset  data set
G -I (B-OEvA) (cen fr comp 1 data set ) (B-OBvA) (cen fr comp 2 data set )
interface to interface to
?ém_gzsi? cen fr_comp 1 intf )"+ *-r (sl'anjuolg'/z;‘ cen fr comp 2 intf
Object Object
No. 21 @ P No. 22
center frame computation 1 data set ) +.{ center frame computation 1 interface )
raw _data _ CenterFrameCommandi.csv simulation
(B-DVA) * CenterFrameFeedbacki.csv (B-OEvA) © \MOST simulation | o MosT.
processed B object
data CenterFrameCommand1.xls command (Object No. 2)
(B-DVA) © CenterFrameFeedbacki.xis B-Dva) ° CenterFrameCommand.csv
feedback

Wo CenterFrameFeedback1.csv

(d) Objects for analytical substructure(center frame)

Fig. b Objects for example hybrid experiment(continued)

the left column, and the processed data attribute
The left
column test 1 object(Object No. 9) also includes the

whose values are the xls format files.

interface to simulation attribute whose value refers
to the left column test 1 interface object. The left
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interface object(Object No. 12)
involves the simulation attribute whose value refers
to and links to the MOST simulation object(Object
No.
feedback files. The left column test 2 object(Object

column test 1

2), and the attributes for the command and



No. 10) is similar to the left column test 1 object
(Object No. 9).

The objects for the right column in Fig. 5c¢ and
the objects for the center frame in Fig. 5d are
similar to those in Fig. 5b. The objects for the right
column in Fig. b5c¢ involve the command and
feedback files in the right column test 1 data set
object(Object No. 16) and the link to the simulation
in the right column test 1 interface object(Object
No. 17). The objects for the center frame in Fig. 5d
involve the command and feedback files in the
center frame computation 1 data set object(Object
No. 21) and the link to the simulation in the
center frame computation 1 interface object(Object
No. 22).

4.3 Possible Implementation of Objects for
Interactions in Example Hybrid Experiment

Fig. 6 shows the possible implementation of the
objects for the interactions in Fig. 5. The display of
the windows in Fig. 6 uses the format developed by
Marullo(2007) and described by Lee et al.(2009) for
the implementation of the objects in the Lehigh
Model. Thus the implementation in Fig. 6 is fully
possible.

The windows in Fig. 6a are for the interactions of
the MOST simulation coordinator in Fig. 3 and are
from the objects in Fig. ba. The objects in Figs. 6b,
6¢, and 6d are for the left column, the right column,
and the center frame in Fig. 3, and are from the
objects in Figs. 5b, 5c, and 5d, respectively.

The MOST Simulation Coordinator window (Window
No. 1) in Fig. 6a is from the MOST simulation
coordinator object(Object No. 1) in Fig. 5a, as
presented in Table 1. It is seen in Table 1 that the
number of an window exactly matches the same
number of the object. This means that there is
one-to-one correspondence between the objects in Fig.
5 and the windows in Fig. 6, and makes easy
understanding of the objects of the Lehigh Model and
direct implementation of the objects for developing a

computer system.

o=

The MOST Simulation Coordinator window(Window
No. 1) in Fig. 6a includes the name and description
items. The items of the Simulation Model, the
Simulation Coordinator Facility, and the Simulations
lead to other windows or other site of the Internet.
For example, the UIUC Lab of the Simulation
Coordinator Facility item can be linked with the UIUC
Lab site. The Simulations item includes MOST
Simulation 1 and MOST Simulation 2 which lead to
the MOST Simulation 1 window(Window No. 2) and
the MOST Simulation 2 window(Window No. 3).

It should be noted that there are close relationships
between the items of the MOST Simulation Coordinator
window (Window No. 1) in Fig. 6a and the attributes
of the MOST simulation coordinator object(Object No.
1) in Fig 5a. All attributes of the MOST simulation
coordinator object in Fig. ba are implemented as items
in the MOST Simulation Coordinator window in Fig.
6a. The value of the “data-valued’ attribute(DVA)
(e.g., the description attribute) of the MOST simulation
coordinator object is implemented to appear in the
MOST Simulation Coordinator window. The values of
the “object entity-valued  attributes(OEVA)(e.g., the
simulations attribute) of the MOST simulation coordinator
object are implemented to lead other windows from
the MOST Simulation Coordinator window. This
applies to all objects in Fig. 5 and all windows in Fig. 6.

The MOST Simulation 1 window(Window No. 2) in
Fig. 6a includes the Simulation Data Set item which
leads to the MOST simulation 1 Data Set window
(Window No. 4), and the Interfaces to Substructures
item which leads to the Left Column Test 1
Simulation Interface window(Window No. 5), the
Right Column Test 1 Simulation Interface window
(Window No. 6), and the Center Frame Computation
1 Simulation Interface(Window No. 7). The MOST
Simulation 1 Data Set window(Window No. 4)
includes the raw data item which includes the
command and feedback files for the substructures,
and the processed data item which includes the xls
format files. The Left Column Test 1 Simulation
Interface window(Window No. 5) includes the Command

and Feedback items which incudes the command and
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To Left Column
Test 1 Window

(Window No. 9)

To Right Column
k=P Test 1 Window

(Window No. 14)

To Center Frame
S Computation 1
Window

(Window No. 19)

To MOST
= =P Simulation 1
Window

(Window No. 2)

5] = AF Lo 935 =Re=l] o] Al&E X o] I3
stolBe|l= F2AFS f% dHoly RlelMe] 328 ud
Yyindow [ simulation: MOST Simulation 2
V\’(;gdﬂw Simulation Coordinator: MOST Simulation Narme: MOST Simulation 2
: Coordinator . Description: This simulation is to reinvestigate the behaviors of three ..
¥ Start Date and Time: ju}y gg Sggg ;00
Name: MOST Simulation Coordinator . End Date and Time: July om
Descripi The simulation is the command center during the .
experiment. All modules communicate directly with the simulation '
[} » Simulation Data Set » Interface to Substructures
» Simulation Model » Simulation Coordinator Linked with ®
Facility . MOST Simulation 2 Data Set Left Column Test 2 Simulation
MOST Simulation Model il g UIUC Lab Interface
UUCLab = = w = m = = Site ' : Right Column Test 2 Simulation
< " Interface
> Simulations . . Center Frame Computation 2
) ) . Simulation Interface
o | MOST Simulation 1 -
* MOST Simulation 2 m = = = w = = = = = = = = = = = = == == T
L4
. :
' V‘,’\]”d%"" Physical Substructure Interface: Left Column
. 0. | Test 1 Simulation Interface
‘ N; Left Col Test 1 Simulati Interf
i . N . . . lame: Lel olumn Test imulation Interface
Window [ simulation: MOST Simulation 1 ’
No. 2 ’
. » Command » Feedback
Name: MOST Simulation 1
Description: This simulation is to investigate the behaviors of three .. ]
Start Date and Time: July 30 2003 10:00 am . LeftColumnCommand1.csv LeftColumnFeedback1.csv
End Date and Time: July 30 2003 11:00 am .
: » » Physical Substructure Test
» Simulation Data Set » Interfaces to Substructures " LeftColumn Test 1 = = m m o = m = = = = = = = = = =
«|1 MOST Simulation 1 Data Set Left Column Test 1 Simulation -?
- Interface =y
L4 . i o i i . .
R : Right Column Test 1 Simulation || V‘{\]gdoew Physical Substructure Interface: Right Column
- . . :
. Center Frame Computation 1 . Test 1 Simulation Interface
L] Simulation Interface LI
N ~ » Name: Right Column Test 1 Simulation Interface
N -
. * .
. . » Command » Feedback
g N A RightColumnCommand1.csv RightColumnFeedback1.csv
'\ .
i ; q " o 5 )
V\’/\;gdof Simulation Data Set: MOST Simulation 1 Data Set . > Physical Substructure Test
Name: Simulation 1 Data Set . Right Column Test 1 = = = = |m = = = = = = = = = = =
.
» Raw Data » Processed Data L
LeftColumnCommand1.csv LeftColumnCommand1.xls Window Analytical Substructure Interface: Center Frame
LeftColumnFeedback1.csv LeftColumnFeedback1.xls No. 7 Computation 1 Simulation Interface
RightColumnCommand1.csv RightColumnCommand1.xls
RightColumnFeedback1.csv RightColumnFeedbacki.xls Name: Center Frame Computation 1 Simulation Interface
CenterFrameCommand1.csv CenterFrameCommand1.xls » Command » Feedback
CenterFrameFeedback1.csv CenterFrameFeedback1.xls
Py - CenterFrameCommand1.csv CenterFrameFeedback1.csv
: :
» Analytical Substructure
Computation
Center Frame Computation 1 m|m = = = = = = = = = = = =
(a) Windows for simulation coordinator(MOST simulation coordinator)
V‘{\;ngSW Physical Substructure: Left Column
Name: Left Column
Description: The left column of the frame was physically tested at Newmark Civil
Engineering Laboratory at UIUC. Because of the fixed connection
Linked with
» Specimen » Facility UIUC Lab
Left Column Specimen UUCLab = = u = = = = = |7 v Site .
- V’L"gd%" Physical Substructure Test: Left Column Test 2
» Physical Substructure Tests M ! » | name: Left Column Test 2
am=" Description: Test 2 of the left column of the frame was to identify
. = M Left Column Test 1 P -m=" Start Date and Time: July 30 2003 1:00 pm
» leftColumn Test 2 = = = m o = m = = = = = = = End Date and Time: July 30 2003 2:00 pm
.
- : H
* 'y » Data Set » Interface to Simulation
V\,/\ir;dogw Physical Substructure Test: Left Column Test 1 Left Column Test 2 Data Set Left Column Test 2 Interface
N . .
Name: Left Column Test 1 . .
Description: Test 1 of the left column of the frame was to identify
Start Date and Time: July 30 2003 10:00 am
End Date and Time: July 30 2003 11:00 am
.
H i q 0
Window | physical Substructure Interface: Left Column
» Data Set » Interface to Simulation No. g Test 1 Interface
-
® ] Left Column Test 1 Data Set Left Column Test 1 Interface m fol m w = = ™ © Name: Left Column Test 1 Interface
]
. : : » Simulation » Command
: * MOST Simulation 1 = = o - LeftColumnCommand1.csv
\{\\l/gwd?:v Experimental Data Set: Left Column Test 1 Data Set T
. -
Name: Left Column Test 1 Data Set plEeedback AL O
LeftColumnFeedback1.csv
» Raw Data » Processed Data
LeftColumnCommand1.csv LeftColumnCommand1.xls
LeftColumnFeedback1.csv LeftColumnFeedback1.xls
- .
H H

(b) Windows for physical substructure 1(left column)

Fig. 6 Possible implementation of objects for example hybrid experiment
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\{‘\‘“gd%" Physical Substructure: Right Column
’ Right Column
Descrlpﬂon The right column of the frame was physically tested at the
Structures and Materials Testing Laboratory at CU. The column
» Specimen » Facility Linked with
| 4 CU Lab
Right Column Specimen CULab = m m mm == = [ Site
" Window | physical Substructure Test: Right Column Test 2
» Physical Substructure Tests * No. 15
-- =W name: Left Column Test 2
w» |4 Right Column Test 1 - - Description: Ie\S‘ 3Zoozvolohae va%gt column of the frame was to identify
. : - Start Date and Time: July pm
, Right Column Test 2 m = = m ju m m = = = = = = = Erd Date and Time: July 30 2003 2:00 pm
] : .
“ » Data Set » Interface to Simulation
) Right Column Test 2 Data Set Right Column Test 2 Interface
\{\\l/gwd?w Physical Substructure Test: Right Column Test 1 : :
Name: Right Column Test 1
Description: Test 1 of the right column of the frame was to identify ..
Start Date and Time: July 30 2003 10:00 am
End Date and Time: July 30 2003 11:00 am
-
: .
Window | physical Substructure Interface: Right Column
» Data Set » Interface to Simulation No. 17 Test 1 Interface
-
. - Right Column Test 1 Data Set Right Column Test 1 Interface m -mm=® - Name: Right Column Test 1 Interface
.’ H H " "
. » Simulation » Command
A MOST Simulation 1 = o ~ RightColumnCommand1.csv
\
Window | Experimental Data Set: Right Column Test 1 Data Set » Feedback R To MOST
No. 16 = ===aaqep Smulation 1
Name: Right Column Test 1 Data Set RightColumnFeedbackl.csv ~ Window
(Window No. 2)
» Raw Data » Processed Data
RightColumnCommand1.csv RightColumnCommand1.xls
RightColumnFeedback1.csv RightColumnFeedback1.xls
: :
(c) Windows for physical substructure 2(right column)
\{‘\‘/'gd%" Analytical Substructure: Center Frame
’ Center Frame
Descll tion: At NCSA, a Pentium 2.4 GHz Windows based machine 512 MB . .
o emory was ullized to Simulate the Test of the fame. using & Linked with
NCSA Site
» Analytical Substructure Model » Analytical Substructure Facility
- .
Center Frame Model NCSA = = = u = = = = = =] Vm‘”d%v Analytical Substructure Computation: Center
; 0. | Frame Computation 2
» Analytical Substructure ® .
Computations - Name: Cemer Frame Computation 2
- Description: J ° aotegboonS% % the center frame was to analytically .
i b Start Date and Time: July pm
<1 Center Frame Computation 1 Les=®" End Date and Tima: July 30 2003 2:00 pm
. Center Frame Computation 2 = o = = = = = = = .
4 : > i > to Si
. Data Set
- ) Center Frame Computation 2
Center Frame Computation 2 Interface
Window : 5 Data Set
No. 1 Analytical Substructure Computation: Center < R
o Frame Computation 1 :
Name: Center Frame Computation 1
Description: Computation 1 of the center frame was to analytically ..
Start Date and Time: July 30 2003 10:00 am N
End Dats and Time: July 30 2003 11:00 am w‘”dgé" Analytical Substructure Interface: Center Frame
: ©- | Computation 1 Interface
» Analytical Substructure » Interface to Simulation ‘ i
Data Set . \d Name: Center Frame Computation 1 Interface
) Center Frame Computation 1_ -
Center Frame Computation 1 Interface 1 » Simulation » Command
v = |1 Data Set
2 ° H MOST Simulation 1 m - CenterFrameCommand1.csv
: ~
[} ~ .
~ To MOST
. Fe k - . ¥
. » Feedbac L R R Simulation 1
) A CenterFrameFeedback1.csv . Window
V,\\{mdg:v Analytical Data Set: Center Frame Computation 1 (Window No. 2)
0. Data Set
Name: Center Frame Computation 1 Data Set
» Raw Data » Processed Data
CneterFrameCommand1.csv CenterFrameCommand1.xls
CenterFrameFeedback1.csv CenterFrameFeedback1.xls
. .
: :

(d) Windows for analytical substructure(center frame)

Fig. 6 Possible implementation of objects for example hybrid experiment(continued)

feedback files for the left column, and the Physical

Substructure Test

Column Test 1 window(Window No.

item which leads to the Left
9). The Right

Column Test 1 Simulation Interface window(Window

No. 6) and the Center Frame Computation 1 Simulation

Interface window(Window No. 7) are similarly imple-

mented, and lead to the

window(Window No. 14) and the
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Computation 1 window(Window No. 19). The MOST
Simulation 2 window(Window No. 3) is similar to the
MOST Simulation 1 window(Window No. 2).

The Left Column window(Window No. 8) in Fig. 6b
includes the Physical Substructure Tests item which
leads to the Left Column Test 1 window(Window No.
9) and the Left Column Test 2 window(Window No.
10). The Left Column Test 1 window(Window No. 9)
includes the Data Set item which leads to the Left
Column Test 1 Data Set window(Window No. 11), and
the Interface to Simulation item which leads to the
Left Column Test 1 Interface window(Window No.
12). The Left Column Test 1 Data Set window
(Window No. 11) includes the command and feedback
files for the left column, and the Left Column Test 1
Interface window(Window No. 12) includes the
simulation item which leads to the MOST Simulation
1 window(Window No. 2). The Left Column Test 2
window(Window No. 10) is similar to the Left Column
Test 1 window(Window No. 9).

The windows for the right column in Fig. 6¢ and the
windows for the center frame in Fig. 6d are similar to
those in Fig. 6b. The windows for the right column in
Fig. 6¢ includes the command and feedback files in
the Right Column Test 1 Data Set window(Window
No. 16) and the link in the Right Column Test 1
Interface window(Window No. 17) to the MOST
Simulation 1 window(Window No. 2). The windows for
the center frame in Fig. 6d includes the command and
feedback files in the Center Frame Computation 1
Data Set window(Window No. 21) and the link in the
Center Frame Computation 1 Interface window(Window
No. 22) to the MOST Simulation 1 window(Window
No. 2).

5. Concluding Remarks

The hybrid structural experiment requires the
proper management of the information related with
the simulation coordinator and the substructures
during the experiment process. The information
includes the divided specimens for substructures at

different facilities, and the commands and feedbacks
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among the simulation coordinator and the substructures.
This paper has described the interactions among the
simulation coordinator and the substructures for an
hybrid
representation of the interactions using the classes
and their objects in the Lehigh Model, and has

presented a possible implementation of the objects for

example experiment, has provided the

developing a computer system.

The implemented system for the hybrid structural
experiments is intended to be used by the researchers
and engineers. The usefulness of the system may be
determined by considering the configurations of the
display windows and items and the user interface
functions such as the saving and retrieving of the
information. The user interface functions are technical
issues of the implementation and are not addressed in
this paper. The configurations of the windows and the
items depend directly on the organizations of the
classes and objects in the Lehigh Model. By providing
an way of formulating and representing the interactions
among the simulation coordinator and the substructures,
this paper contributes towards developing the compre-
hensive system for the hybrid structural experiments.
The specific features and contributions are as follows:

(1) The simulation coordinator and each of the

substructures in the example hybrid experiment

have their own data sets which include the

command and feedback files, and have the

interface links to its related simulation
coordinator or substructures.

(2) The simulation coordinator is linked with all the
substructures and includes the command and
feedback files for all the substructures.

(3) Each of the substructures is linked with the
simulation coordinator and includes the command
and feedback files for the simulation coordinator.

(4) The strong relationships among the simulation
coordinator and the substructures makes a
clear and distinct access to the information
involved in the interactions.

(5) The objects and their attributes for the
interactions in the example hybrid experiment

can be directly implemented into display



windows and items in the windows in a
computer system.

The representation of interactions presented in this
paper is for the example hybrid experiment, but can
be extensively used for other kinds of hybrid
experiments. The way of representing the interactions
depends on the organizations of classes of the Lehigh
Model. For other types of data models which have
different organizations of the information, the interac-
tions would be represented differently. However, the
underlying ideas of representing the interactions in
this paper can be applied for other types of data

models for the hybrid structural experiments.
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